LFundamentals of Word Processing J

Introduction

In today's digital world, word processing is an essential skill used for creating, editing, formatting,
and managing text-based documents. This chapter introduces the fundamentals of word processing,
beginning with the basic concept and characteristics of word processors that distinguish them from
traditional typing methods. It also explores commonly used word processing software. Using
LibreOffice Writer, we will learn how to create and save text documents, utilize templates, navigate
through content, and other important features related to the word processor. By the end of this
chapter, students will understand how to create text documents and carry out basic word processing
tasks useful for school assignments and projects.

Introduction to Word Processing and Word Processor

Word processing refers to the activity of creating, editing, formatting, and printing text on a
computer. It is useful for writing various documents such as letters, essays, reports, and more. With
word processing, we can easily correct mistakes, change the appearance of text, and add elements
like images or tables.

A word processor is a computer program designed for word processing. It allows users to type and
manage text on their computers. This essential tool has replaced the traditional typewriter, making
writing much more convenient. We can use a word processor to type, edit, format, save, and print
text-based documents such as letters, reports, and school assignments. Some popular word
processors include LibreOffice Writer, Microsoft Word, and Google Docs. These programs offer
various features that enhance productivity and creativity. For example, they come equipped with
spell checkers and grammar suggestions, helping to ensure that our writing is free of errors.
Additionally, they provide a wide range of fonts and styles, allowing users to customize their
documents to meet their personal or professional needs. In this chapter, we will use LibreOffice
Writer software to learn the fundamentals of word processing.

Characteristics of Word Processor

A word processor offers a variety of helpful features that simplify the process of writing and editing
documents. Let us explore some useful characteristics of word processors that make them valuable
tools for students, teachers, and professionals.

° Text Formatting:We can change the look of the text using font style, size, and color. It
also allows alignment, bold, italics, and underline.This makes our document more
attractive and readable.

° Spell Check and Auto Correct: Word processors can check our spelling and highlight
mistakes. They can also fix common typing errors automatically. This feature helps us to
improve accuracy in the document and saves time.

° Multimedia Elements: We can add images, tables, symbols, and more multimedia
elements into our document.
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° Templates and Styles: We can use ready to use pre-formatted document templates to
create professional documents very quickly.

° Export as PDF or Print Options: We can save our document as a PDF file or print it
directly to the connected printers.

° WYSIWYG Interface: WYSIWYG stands for "What You See Is What You Get." The
document on the screen looks the same when we print it. It helps users see the final
output while editing the document.

Software for Word Processor

Word processor software can be broadly classified into three types based on the platforms they
operate on and how they are accessed:Desktop Tools, Mobile Tools, and Online Tools. Table 6.1
shows summary table of various categories of Word Processor software with key properties and

examples.

Type Works On Internet Software Example
Needed Installation

Desktop Tool Personal Computer/ | Occasionally Necessary Writing areportin
Laptop Libre Office Writer
Mobile Tool Smartphone/Tablet Frequently Necessary Editing aresume on

needed (Apps) the go inmobile

Online Tool Any device using Always Notneeded Joint editing in

web browser needed Google Docs by

many users
Table 6.1 Categories of Word Processor
Desktop Tools

These are software programs installed and run on personal computers or laptops. They offer full
features, fast performance, and usually work offline. They are used for professional and academic
work like document creation, coding, editing, etc. LibreOffice Writer, Microsoft Word, Excel,
Adobe Photoshop, etc. are examples of desktop based tools.

Desktop tools like MS Word and LibreOffice Writer are traditional word processing applications
that are installed directly on a computer's operating system. These tools are rich in features such as
advanced formatting, printing, exporting documents into different formats, mail merge, templates,
and integration with other software. They are commonly used in schools, colleges, and offices for
creating detailed reports, letters, and professional documents. Since they work offline, they are
highly reliable even without internet access.

Mobile Tools

These categories of tools are specialised mobile applications, also known as Mobile DTP (Desktop
Publishing) Software. They are designed to run on smartphones or tablets. They are widely used for
on-the-go use and optimized for touch screens. But they offer relatively fewer features than desktop
versions of the same program. They are useful for quick edits or viewing during traveling. They
enable us to create and design documents, brochures, flyers, posters, and various other printed or
digital media directly from our mobile devices.
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Google Docs App, WPS Office Mobile, Microsoft Office Mobile, etc., are widely used mobile-based
word processors. They are designed specifically for touch screen based devices like smartphones
and tablets. This category of word processor offers essential document processing features in a
compact format, allowing users to create, view, and edit documents while on the go. They are
convenient for quick edits, reading documents during travel, or making last-minute changes before a
meeting. Many of them also support cloud storage and syncing across devices. It benefits students,
small business owners, content creators, and professionals who need quick document management.
Some of'the key features of mobile-based tools are listed below:

e  Ready-to-use templates are available for various print and social media content.
e  Tools and features are available for inserting and editing text, images, and graphics.
e  They can export designs in PDF, PNG, or JPG file formats.

e  Cloudintegration and easy sharing options are available directly from mobile devices.

Online Tools

These categories of software run in web browsers (Chrome, Firefox, etc.) without needing
installation. They store data and documents in the cloud and often support real-time editing and
collaboration. We need an internet connection to use these categories of software.

Google Docs, Microsoft 365 Word Online, WPS Office Word Online, Canva, etc. are widely used
examples of online word processors.

These tools can be used using any web browser and do not require any software installation. These
tools are excellent for collaborative work, as multiple users can edit the same document in real-time
from different cities. In these categories of word processors, changes are automatically saved to the
cloud, ensuring data safety and accessibility from any device with internet access. They are widely
used for teamwork, classroom activities, and remote work environments.

An Overview of LibreOffice Suite

The LibreOffice suite is widely used Open Source Software, which is freely available for everyone
to use. LibreOffice suite includes Writer for word processing, Calc for spreadsheets, Impress for
presentations, Draw for graphics and flowcharts, Base for databases, and Math for formula editing.
Key advantage of LibreOffice suite is no licensing fees and its cross platform usability. It can runs on
multiple operating systems, such as Microsoft Windows, macOS, Ubuntu and various Linux
versions.

In next section, we will study widely used word processing software, the LibreOffice Writer. If it is
not installed on your computer, then you can download it from following website:
https://www.libreoffice.org/

Introduction to LibreOffice Writer

The Writer is a free and powerful word processing software that comes with the LibreOffice suite.
It offers many features that can be used to create letters, books, project reports, and more. We can
insert graphics like images from other sources into the Writer's document. Writer can export
document files as HTML, XML and PDF. It can save files in many file formats, including Microsoft
Word (.docx).

Let us understand how to open, create, and manage documents in LibreOffice Writer.
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Opening LibreOffice Writer

We can open LibreOffice Writer software using following three options:

1. LibreOffice Suite Launcher (Refer figure 6.1)
2. Start Menu of Operating System (Like Ubuntu OS)
3. Desktop Shortcut Icon
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Figure 6.1 : Opening Writer from LibreOffice Suite Launcher

Parts of the Main Writer Window

The main screen (homepage) of the Writer software is shown in figure 6.2. Important sections of the

Writer are as follows:
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Figure 6.2 : Parts of the Writer Window
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Title bar

It is located at the top of the Writer window. It shows current document's file name. When the
document is not saved, the filename will appear as Untitled N, where N is a number. In our case it is
visible as “Untitled 1” in the title bar. Untitled documents are numbered in the order in which they
are created by user.

Menu bar

The Menu bar is located just below the Title bar. It provides access to all the main commands and
features of the Writer application. They are organized into categories like File, Edit, View, Insert,
Format, Style, Table, Form, Tools, Window and Help. It helps user to perform various tasks related
to the editing and managing documents efficiently. When one of the menus is selected, a submenu
drops down to show further available options. For example, observe Figure 6.3 related to the File
Menu, when we click on File Menu, it will show all the features related to the File Management.

Untitled 1 - LibreOffice Writer
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Figure 6.3 : File Menu

Standard Toolbars

In a default LibreOffice installation, the Standard toolbar is just located below the Menu bar (Figure
6.2). It contains commonly used tools and shortcuts for quick access to basic functions like creating a
new file, saving a file, printing, copying, pasting, undo-redo actions, and many more useful features.
It helps users perform frequent tasks without navigating through menus. This toolbar speeds up our
document editing process, and save time. Such toolbars can be docked (fixed in place) or floating.
Docked toolbars can be moved to different locations on the Writer's window as per our requirements.
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) To display a new toolbar, go to View— Toolbars on the Menu bar, then click the name of
a toolbar that you want to add from the list. An active toolbar shows a check mark along
with its name.

° To hide a toolbar, go to View— Toolbars on the Menu bar and deselect the toolbar, or
right-click in an empty space between the icons on a toolbar and select Close Toolbar.

° Locking and unlocking toolbars: We can lock all toolbars, or individual toolbars, into
place so they cannot be moved. When all toolbars are locked, we cannot unlock
individual ones. To lock all toolbars in place, go to View— Toolbars on the Menu bar and
select Lock Toolbars. Restart LibreOffice for this change to take effect. To unlock all
toolbars, click on Lock Toolbars again.

Formatting Toolbar

This toolbar provides quick access to various text formatting options. It helps us to change the
appearance of text and paragraphs easily. It allows us to apply font styles, sizes, colors, bold, italics,
underline, and alignment options like left, center, right, and justify. We can also set line spacing,
bullets or numbering, and adjust indents directly from this toolbar. Figure 6.4 shows important
features related to the formatting toolbar. It helps in enhancing the visual structure and readability of
the document.
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Figure 6.4 : Formatting Toolbar

Remember that the Formatting Toolbar displays only the most commonly used shortcuts for
formatting the document. This toolbar does not show all the formatting features that LibreOffice
Writer offers. To access the complete set of formatting tools we need to open the Format Menu from
the Menu bar. Refer to figure 6.5, which highlights the Format Menu and shows how to use all
available formatting features.
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Figure 6.5 : Format Menu and Submenu
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Sidebar Click Here to See Al upum-vl_
The Sidebar is a panel on the right side of the screen that gives quick — =
access to useful tools and settings. It includes sections like Properties, i z >
Styles, Gallery, Navigator, Page, Find and more. Users can quickly R &
change text formatting, apply styles, insert images from Gallery, or :::E-F;: e
move around the document using the Sidebar. It saves time by ret

reducing the need to go through menus. The Sidebar can be shown or ::s--u e °
hidden as per our requirements, hence it is helpful for both beginners A 0
and expertusers. Itis shown in figure 6.6. A
Status bar Figure 6.6 : Side Bar

The Status Bar provides quick information about the current document that we are processing. As
shown in figure 6.7, it displays details like the page number, word and character count of the content
in the document, language, and zoom level. It also shows the document's insertion mode
(insert/overwrite) and selection mode. Users can easily adjust the zoom level of the document and
switch between page views from here. This bar informs us about the document's current status
without visiting various menu and submenu options.

&4 Pagelof1 4 words, 29 characters Default Page Style English (India) oI OO0 - ——l— e 120%

Figure 6.7 : Status Bar

The status bar shows more details when we click on its parts. For example, clicking “Words and
Characters” shows more information about the document. In figure 6.8, two lines are written in the
document, and the second line with 10 words is selected. Details for the selected part and the whole
document are visible in the expanded Word Count window, as shown in figure 6.8.

J
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Figure 6.8 : Status Bar — More Details
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Other useful features of Writer

° Rulers: The Rulers helps us to set margins and indentations for the document. They provide
a visual guide along the top and left edges of the document. This helps us in aligning text
and objects precisely on the page. The horizontal ruler across the top of the document is
visible by default but the vertical ruler on the left is hidden by default. To enable the
vertical ruler, choose View—Rulers— VerticalRuler on the Menubar, or choose
Tools— Options— LibreOfficeWriter— View, and then tick the Verticalruler.

N

Horizontal Ruler

'<15Vertical Ruler

Figure 6.9 : Rulers

e  Minimize, Maximize, Close: Three . 1
buttons visible on the top-right corner I i
of Writer software as shown in figure F' = O X

6.10. They have the following uses: 5

o Minimize: Hides the Writer

- - - Minimize Close
window from view and places it Maximize
on the taskbar.
o Maximize: Enlarges the Writer Figure 6.10 : Minimize, Maximize and Close

window to fill the entire screen for better visibility.

o  Restore Down (when maximized): Returns the window to its previous smaller size.

o  Close: It will close the Writer application and ask to save document, if there are any
unsaved changes.

° Document views: Writer has three ways to view and edit a document: Normal, Web, and
FullScreen. To change the view, go to the View menu and select the required view.

o Normal view: Itis the default view in Writer. It shows how the document will look when
printed or exported as a PDF. In this view, we can use the Zoom slider and the View
Layout icons on the Status bar to change the magnification. We can also hide or show the
headers and footers and the gap between pages.

o Web view: It shows how the document will look if viewed in a Web browser; this is
useful when creating HTML documents. In Web view, we can use only the Zoom slider.

o Full Screen view: In Full Screen view, no toolbars or sidebar are displayed; the
document is visible in the full screen area. To exit Full Screen view and return to the
previous view, press the Esc key or click the Full Screen button.We can use
Ctrl+Shift+J to enter or exit Full Screen view.

Let us understand steps to create, save, and close a new document using the LibreOffice Writer
software.
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Creating a New Document

We can start a new, blank document in Writer in different ways. If a document is already open in
LibreOffice, the new document is created in a new window. To start a new document in LibreOffice
Writer, we can follow any of the following steps:

e  Open LibreOffice on your computer. We can do this by clicking on the LibreOffice icon or
finding it in applications menu of the Ubuntu operating system.

° Once LibreOffice is open, we can see the LibreOffice Suite Start Center on screen. From here,
click on “Writer Document” to open a new text document, as shown in figure 6.1 related to
opening Writer from LibreOffice suite launcher.

e  Alternatively, if we already have LibreOffice Writer open, we can create a new document

by clicking on “File” in the menu bar at the top of the screen. Choose File—New— Text
Document. A new, blank document will open, ready for us to begin typing. We can also use
Ctrl+N command to open a new document when Writer is already open.

Saving a Document

Saving a document ensures that our document content is stored safely for future use in computer. By
default, LibreOffice Writer saves documents in the ODT (Open Document Text) format. This format
is open-standard, supported by many other word processors. A document can be saved using various
save options visible in the File menu as shown in

Save Ctrl+S figure 6.11.
E Save As... Ctrl+Shift+S We can save a document by clicking on the Save icon
in the toolbar or using the command Ctrl + S. When
Save Remote...

we are saving a document first time, Writer will ask

us to choose a file name and location. We can also use

Save a Copy...

Save As to create a new copy of the document with a

Figure 6.1 : Document Save Options different name, format, or location.

We can use any of the following options to save document.

° Save (Ctrl + S command): It is used to save the content of the current document with its

existing filename and location.

) Save As (Ctrl + Shift + S command): Save As option is used to create a new document with
the same content as in current document. This option is also useful for changing the filename,
selecting a different file format, or saving the same document in a new location on our

computer.

° Save Remote: It is used when we want to store our document on a remote server or location,

such as cloud storage.

° Save a Copy: This allows us to save an additional copy of existing document under a different

name or in a different location, keeping the original file open for further editing.

° Save All: This option is used to save all the currently open documents, ensuring that no

changes are lost in any of the files. Content of all the files will be saved in a single command.
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Closing a Document

To close a document, go to File—Close in the Menu bar, or click the X located at the top of
document's window. When we close the
last document, the LibreOffice Suite

. Save Document? X
Start Center will appear on the screen.

i Save changes to document “Untitled 1” before closin
If the document has unsaved changes, L i 4

Writer will prompt us to Save, Don't Your changes will be lost if you don't save them.
Save, or Cancel before closing as shown
in figure 6.12.We need to decide
whether to save or discard our

document changes. Figure 6.12 : Close Document

Exiting LibreOffice Writer

Don't Save Cancel

To close the LibreOffice Writer application completely (not just close a document), we can use any
ofthe following methods:

e  Click on File— Exit from the menu bar.
e  Or, click the Close (x) button at the top-right corner of the Writer window.
e  Or, use the keyboard shortcut A/f + F4.

If we have any unsaved documents open, Writer will ask us to save our work first before exiting the
application.

Opening an Existing Document

There are different ways to open an existing document in a Writer. When no document is open,
follow these steps:

° Start LibreOffice Writer from the OS Start menu or Desktop shortcut.
° Click on File—Open from the menu bar or Press Ctr/ + O shortcut on keyboard.
An Open dialog box will appear.
° Browse through your computer's folders and select the desired document.
° Click Open to load the document into Writer.
Alternatively, if the document was opened recently, we can go to File—Recent Documents and

select it directly from the list. Note that renamed or relocated documents can still be listed in the Start
Center. Selecting such document will give an error message that the file does not exist.

Writer allows us to open files of various formats, such as .odf, .txt, .docx, and .doc. It provides

flexibility in handling different document types.

Using Templates

A template in Writer is a model document that is used to create other documents. They are pre-
designed document layout that serves as a starting point for creating new documents. It contains
predefined formatting, styles, fonts, text or images that help maintain consistency and save time.
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Templates are useful when we need to create multiple documents with a similar structure, such as
letters, resumes, reports, or bills. Instead of formatting each new document from the beginning, we
canuse a template and just fill in our required content in a new document.

We can create a template in Writer to save time and keep things consistent. For example, we might
design a student progress report template that automatically includes our school's logo and address
on the first page. Then, whenever we open that template to create a new student report, the logo and
address will already added in new document saving our time.

Similarly, if we are writing a letter, we can use a letter template that has the sender's and receiver's
address blocks, date, subject line, and closing section already formatted as shown in figure 6.14. We
just need to type our new message and fill in the specific details, rest of the details are already
available in the template. Hence we do not have to type or format a full document again, saving our
document preparation time.

Creating a document from a template

There are many methods available to create a new document based on an existing template in Writer.

Templates *
fearch Filter rh1D='{uth'l'I-"| lﬁllhnrgohts Manage ~

Modern m,.:.: m;m tant-  Modem butiness letter senif SEl@Gt* cateﬂﬂﬂeﬁ
a B
| I

e Bussnesscard with logo o Resurne
= LT Titie: CV
| I,'lrl.-gw Personal Correspondence
and Documents
|
I.
Default Maodem Semple
ag
oo
Help Close Cper

Figure 6.13 : Templates Window

Letus understand the quickest and most simple method of creating a document.
e  Open LibreOffice Writer.
e  Go to File—New— Templates or we can also use a shortcut Ctrl+Shift+N.

e  The "Templates" dialog box will appear as shown in figure 6.13. In this dialogbox,
we can see a list of available templates. Some of the templates come with the LibreOffice
installation. We can filter the available templates using Filter drop-down list available on
the top of the Template window.
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o Categories: Templates are organized into categories like Business Correspondence,
Personal Correspondence and Document (CV, Resume), etc. We can select the
required category as per our need.

o My Templates: Custom-saved templates created by us are visible here.
) Select the template you want to use, and click "Open".

A new, unsaved document will open, pre-formatted with the content and styles as per the chosen
template. We can now start typing our content in the document. Figure 6.14 shows the sample letter
template opened when we select a category called a Modern Business Letter. You need to just add
your details into this pre-formatted letter.

—

L s P i " don_ A A . PR i b

<SENDER'S NAME> Put
<Company Name> your

<ADDRESS STREET>
<ADDRESS POSTAL CODE><ADDRESS CITY>
<smre> | here

<TmLe><RECIPIENT'S NAME>
<ADDRESS STREET>
<ADDRESS POSTAL CODE><ADDRESS CITY>
LSTATES
24 July 2025

Dear TTLE=RECIFENT 5 NAMES.

This i5 & sample letter This is a sample letter. This is a sampile letter. This is a sample letter This is a
sample letter. This is a sample letter This is & sample letter. This is & sample letter. This is 8 sample
letter. This is & sample letter. This is & sample letter. This is a sample letter.

We are looking forward to hearing from you 500N

Yours sincerely.

CSENDIRS NAMES

Figure 6.14 : Letter Template

Navigating Content of a Document

Navigation in Writer refers to the process of moving through the content of a document efficiently. It
includes using tools like the Scroll Bar, Keyboard Shortcuts, Navigator, and Find and Replace
features to quickly jump to different parts of the document. Navigator helps us in going to a specific
page, heading, table, image, or section of a document.It is important to learn navigation techniques
as it offers following important benefits:

° Saves time by allowing direct navigation to headings or specific pages.
° Improves efficiency by enabling quick access to elements like tables and comments.
° Helps in managing large documents like lengthy reports or books.

Let us understand important navigation features of the Writer.
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Using Scroll Bars

Writer provides both vertical and horizontal scroll bars for easy navigation in the document.

° Vertical Scroll Bar: It allows us to move up and down through the pages of document.
Itis available near the Sidebar of the document.

Horizontal Scroll Bar: Enables side-to-side navigation, which is especially useful for

wide documents containing content like spreadsheets or tables. It is available just above

the Status bar of the document. It is visible only when a document width is greater than
the screen size of the Writer application.

) Quick Navigation using Mouse: We can click and drag the scroll bars or use the scroll
wheel on our mouse for faster movement.

Keyboard Navigation

Keyboard shortcuts provides good control over the cursor position in the document:

° Arrow Keys: We can use the arrow keys of our keyboard to move the cursor character
by character or line by line.

° Page Up / Page Down: We can jump up or down one page at a time using page-up or
page down key of the keyboard.

e  Ctrl+Arrow Keys: For faster navigation, hold the Crrl key | Nevister (x|
while pressing the arrow keys to move by words or | ;= V] aw
paragraphs. fjﬂ_D_E_J 20 =.

Document Navigator Tool ¥

The Document Navigator is a powerful tool for quickly locating £ Tables

different elements within our document. The Navigator provides a B L x =

structured overview of your document, showing headings, tables, B OLE object

images, bookmarks, and more, allowing for quick access to specific Wi

sections.

° To open and accessing the Navigator tool, Press F5 or go to

View— Navigator. This will open a navigator tool as shown o
infigure 6.15. v

GoTo Page Figure 6.15 : Navigator Tool

Use following options for direct navigation to a specific page number of our document:

° Go To Page: To jump to specific page number, go to Edit—Goto Page or use shortcut

Ctrl + G. This feature is very useful to save our time specifically while working with
very lengthy documents like books or annual reports.

Zoom and View Modes

Adjusting the view size of document can make editing more comfortable. We can set document view
size using a zoom tool.
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° Zoom In/Out: Use the zoom slider on the toolbar or go to View—Zoom to change the
size (magnification level) of a document. It is shown in figure 6.16.

r
]
]
i
1
I
I
I
¥
.

O BE e —— + 100%

Status Bar

To Reduce Size To Enlarge Size

Figure 6.16 : Zoom Slider

e  View Options: Choose from different viewing modes such as Normal, Web, or Full
Screen to suit your task.

Page Preview and Print

Before printing, use the Page Preview option to see how document will look on paper. To see the
print view, go to File— Print Preview or use shortcut Ctrl + Shift + O. To print the document on the
connected printer, go to File— Print or use shortcut Ctrl+P.

Keyboard Shortcuts in Writer

Table 6.2 covers some keyboard shortcuts that can significantly enhance your document editing
experience in Writer.

Sr. Shortcut Key/ | Useof Command

No. Commands
1 Ctrl+N Create anew document
2 Ctrl+0O Open an existing document
3 Ctrl+S Save the current document

4 Ctrl + Shift+S Save file with different name or at different location (Save As)

5 Ctrl+P Print the current document

6 Ctrl+Z Undo the last action

7 Ctrl+Y Redo the last undone action

8 Ctrl+C Copy selected text or object

9 Cul+V Paste copied content at the cursor position

10 Ctrl+B Apply or remove bold formatting to selected text

Table 6.2 : Useful Keyboard Shortcuts in Writer
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For detailed information about the LibreOffice Writer, visit the official documentation at the
following link: https://documentation.libreoffice.org/en/english-documentation/. From this
webpage, you can download the LibreOffice Writer's Guide in PDF format.

Summary

In this chapter, we explored the fundamentals of word processing and the purpose of a word
processor. We learned about the key characteristics that make word processors powerful tools for
creating and editing documents. Different types of word processor software were discussed. The
chapter introduced the LibreOffice Suite, with a special focus on LibreOffice Writer. The Writer's
user-friendly interface and various components like the Menu Bar, Toolbars, Sidebar, and Status Bar
are discussed. We also understood the use of important features such as rulers and document viewing
options. During the chapter, tasks such as creating, saving, opening, and closing documents were
explained in detail. We have also learned, how to use ready-made templates to simplify our
document editing work. Finally, we covered how to navigate through a document effectively using
different tools. In the upcoming chapter, we will thoroughly explore the tasks involved in document
editing and formatting.

EXERCISE

1.  Whatisaword processor, and how does it help in creating and editing documents efficiently?
2. List and describe at least four important characteristics of a word processor.

3. What are the different types of word processor software available, and how are they
categorized?

4.  What is LibreOffice Suite, and why is LibreOffice Writer very popular in educational
institutions?

5. Briefly explain the various parts of the LibreOffice Writer main window. Briefly describe use of
the Menu Bar, Toolbars, Sidebar and Status Bar.

6.  Whatisthe purpose of the rulers in LibreOffice Writer?

7.  How can we minimize, maximize, and close a document in LibreOffice Writer?

8.  Explainkey steps involved in creating, saving and opening a document in LibreOffice Writer.
9.  Explain the advantage of using pre-designed templates while working with a document.

10. Whatare the different ways to navigate through a long document in LibreOffice Writer?
11. State whether true or false.

(1) LibreOffice Writer is a spreadsheet software used for performing calculations.

(2)  Word processors like LibreOffice Writer allow users to edit and format text easily.
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The Status Bar in LibreOffice Writer shows information like page number, word and
character count.

Minimize and Maximize buttons are used to control the size of the Writer window.

The Writer application can be used to open only .ODT type of files.

12. Fill-in the blanks.

(1)

)

)

4

)

A is a software application from LibreOffice Suite used to create, edit, and
format text documents.

A provides a ready-made layout that can be used to create similar types of
documents based on pre-defined formatting.

The bar in LibreOffice Writer contains menus like File, Edit, View, Style,
Format, Insert, etc.

To open an existing document in LibreOffice Writer, we can use the option
from the File menu.

The shortcut key can be used to see the print preview of a document.

13. Multi-choice question. Choose the most correct answer.

(M

)

3

“)

)

Which of the following is an example of a word processor?

(a) MS Paint (b) LibreOffice Writer

(c) VLC Player (d) Google Chrome

What is the primary function of a word processor?

(a) Play audio files (b) Create and edit text documents
(c) Design websites (d) Browse the internet

Which of the following is NOT a characteristic of a word processor?

(a) Spell check (b) Text formatting (c) Video editing (d) Copy and paste
LibreOffice Writer belongs to which category of software?

(a) Web browser (b) Open-source office suite

(c) Image editor (d) Database manager

Which component of LibreOffice Writer displays page number, word count, and
language settings?

(a) Sidebar (b) Formatting Toolbar

(c) Status Bar (d) Menu Bar
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(6)

(7

(8)

©)

(10)

What is the purpose of using a template in LibreOffice Writer?
(a) To play music in background

(b) To get a pre-formatted document layout

(¢) To increase font size

(d) To convert the file into PDF

Which option allows us to save a document with a different name or location in
Writer?

(a) Save (b) Close (c) Save As (d) Export

What does the Maximize button do in Libre Office Writer?

(a) Closes the document (b) Minimizes the window

(c) Opens the help menu (d) Enlarges the window to full screen

Which of the following is used to move through the pages of a long document in
Writer?

(a) Title Bar (b) Search Bar (c) Status Bar (d) Scroll Bar

Which of the following shortcut can be used to open a Template window in Writer?

(a) Ctrl+S (b) Ctrl+ Shift+ N (¢) Ctrl+P (d) Ctrl+0

Laboratory Exercise

1.  Create a document in LibreOffice Writer to maintain details related to your hobbies. Perform
steps as mentioned below:

Make the heading “My Hobbies”on first page.

Write first paragraph about some of your hobbies.

Write a second paragraph about "My Favorite Hobby".

Use basic formatting: apply bold to the title, change font size and colour.

Save the document as MyHobbies.odt on the Desktop.

2. Create a document to maintain details about the courses which you are currently learning.
Perform following steps:

e Create adocument and save it in your computer with the filename as “MySubjects.odt”.
e Write name of at-least five subjects in it.
e Apply appropriate formatting on the details written by you.
e Save and close your file.
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3.  OpenMySubjects.odt file from your computer, and perform following tasks:
e Addone more paragraph with details about who is teaching which course.
e Create anew document using Save As utility.
e Savethisnew file as “MySubjects-and-Teachers.odt” file name in your computer.

4.  Create anew document to save details related to your School Magazine. Try to create more than
3 pages in this document to save details like Science Day Celebration, Annual Sports Day,
Winners of the Dance Event.Perform following tasks:

° Save your file with “SchoolMagazine.odt” filename.

° Write School name and address on the first page of magazine.

° On the second page, write details about yourself (Roll number, Name and Address).
° On the next page, write a short paragraphs about various events.

° Create a multi-page document with appropriate formatting.

5. Createadocument in Writer using built-in template. Perform following tasks.

° Click File— Templates— ManageTemplates.
° Choose a template such as "Resume” or “Business Letter".
° Fill in the some sample details. You may consider to write a sample letter to your friend.

° Save the document as “MyLetter.odt”.

%D % R
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